Thank you for purchasing a XY stage control software. To ensure the safety, obtain optimum performance and familiarize yourself fully with the use of this product, we recommend that you study this manual thoroughly before operate it.

This manual describes Multi Point Time Lapse software only to be used on FV300 or FV500. Together with this manual, please also read “FV300/500/TIEMPO User’s Manual” so that you can understand the overall operation method.

Keep this manual in an easily accessible place near the work desk for future reference.
CAUTION

① It is prohibited to reproduce, copy or duplicate a part or the whole of this software and manual.
① The information described in this manual may be subject to change without notice.

Registered Trademarks

Microsoft, Microsoft Windows, Excel for Windows are registered trademarks of Microsoft Corporation.
Other brand names and product names are trademarks or registered trademarks of their respective owners.
NOTATION IN THIS MANUAL

This manual has been compiled based on the following notation rule.

◊ Notation of Caution, Notes and Tips

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Caution]</td>
<td>Caution for preventing injuries of the user or damage to the product (including the surroundings).</td>
</tr>
<tr>
<td>![Note]</td>
<td>Note for the user.</td>
</tr>
<tr>
<td>![Tip]</td>
<td>Hint or one-point advice which can be a reference for the user.</td>
</tr>
</tbody>
</table>

◊ Notation of Menus, Command Buttons and Dialog boxes

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Acquire]</td>
<td>The name of a panel, dialog box, list box or check box is enclosed inside square brackets ([ ]).</td>
</tr>
<tr>
<td>&lt;OK&gt; button</td>
<td>The name of a button in a panel or dialog box is enclosed inside angle brackets (&lt; &gt;).</td>
</tr>
</tbody>
</table>

◊ Notation of Mouse Operations

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clicking</td>
<td>Action of pressing then immediately releasing the mouse button</td>
</tr>
<tr>
<td>double-clicking</td>
<td>Action of clicking the mouse button successively twice.</td>
</tr>
<tr>
<td>dragging</td>
<td>Action of moving the mouse while holding the mouse button and releasing the mouse button at the desired position.</td>
</tr>
</tbody>
</table>

(Note) In this manual, click, double-click and drag should use left button of the mouse unless otherwise specified.
Notation of key operations

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>The name of a keyboard key is enclosed inside \textbf{\ldots} .</td>
</tr>
<tr>
<td>Alt $! + !$ F1</td>
<td>The positive sign (+) expresses the combination of more than one key operation. For example, \textbf{Alt $! + !$ F1} refers to pressing the \textbf{Alt} key while holding the \textbf{F1} key down.</td>
</tr>
<tr>
<td>Direction Keys</td>
<td>Generic names given to the $\rightarrow$, $\leftarrow$, $\uparrow$, $\downarrow$ keys.</td>
</tr>
</tbody>
</table>

Notation of system-specific terms

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XY observation</td>
<td>Refers to observation with XY scanning. (The same principle also applies to other observations such as XZ, Xt, XYZ, XYt and XYZt.)</td>
</tr>
</tbody>
</table>

In this manual, there are some modified panels and dialog boxes partly changed in window size and gray characters are also modified for enabling users to read them easily.
NOTES ON THE FLUOVIEW MANUALS

This instruction manual is the instruction manual for Multi Point Time Lapse software to be used on FV300, FV500 or FV-TIEMPO. Expressing “Refer to FV300/500/TIEMPO User’s Manual” in this manual means that the user is requested to read the instruction manual for the FV300, FV500 or TIEMPO the user possesses.

Although the descriptions in this manual are common for the FV300 and FV500, the figures always refer to the time course software for the FV500.

BEFORE USE

Refer to Volume [SAFETY GUIDE] in the “FV300/500 User’s Manual”
Be sure to read this volume before use.

SPECIFICATIONS

Refer to Volume [SAFETY GUIDE] in the “FV300/500 User’s Manual”.

SYSTEM OUTLINE

Refer to Volume [SYSTEM OUTLINE & SPECIFICATION] in the “FV300/500 User’s Manual”.

MAINTENANCE

Refer to Volume [MAINTENANCE] in the “FV300/500 User’s Manual”.

TROUBLE Q & A

Refer to Volume [TROUBLE Q & A] in the “FV300/500 User’s Manual”.
1 Software Description

1-1 Starting the Software ................................................................. 1-1
1-2 Moving the Stage ....................................................................... 1-3
   1-2-1 Specifying approximate position on stage .......................... 1-3
   1-2-2 Moving the Stage Step by Step ......................................... 1-4
   1-2-3 Moving the Stage to the Specified Coordinate Position ...... 1-5
   1-2-4 Moving the Stage to a Preset Position .............................. 1-6
   1-2-5 Moving the Stage to an Indexed Area .............................. 1-7
1-3 Registering the Stage Coordinate Information .......................... 1-10
   1-3-1 Auto Registration of Stage Coordinate Information Specifying Index Numbers 1-11
   1-3-2 Auto Registration of Stage Coordinate Information Specifying Region ...... 1-12
1-4 Menu List .................................................................................. 1-14
   1-4-1 [XY Stage Control] Window ............................................. 1-14
   1-4-2 [Stage Map] Window ....................................................... 1-16
1-5 Stage Coordinate Information Markings Used in the [Stage Map]
   Panel ......................................................................................... 1-17
1-6 Enlarging the [Stage Map] Panel ................................................. 1-18
1-7 Changing the Settings ............................................................... 1-19
   1-7-1 Setting the Stage Control Parameters .............................. 1-19
   1-7-2 Alignment of moving direction ........................................ 1-21
   1-7-3 Changing the Index Size ................................................ 1-22
   1-7-4 Default setting of file name to be registered automatically ...... 1-23

2 Multipoint Time-Lapse Observation .............................................. 2-1

2-1 Starting This Software and Protocol Processor ....................... 2-2
2-2 Connecting This Software and Protocol Processor .................. 2-3
2-3 Setting the Stage Coordinate Information ............................... 2-5
2-4 Editing the Protocol File............................................................. 2-7
   2-4-1 Setting repeated processing to protocol processor .......... 2-7
   2-4-2 Setting information that meets with track selected to FLUOVIEW software .2-8
   2-4-3 Display of input supporting function to track of protocol processor .......... 2-8
2-5 Acquiring Images ..................................................................... 2-9
2-6 Z range Offset ................................................................. 2-10
2-7 Editing Images ................................................................. 2-11
2-8 Saving Images ................................................................. 2-11
2-9 Saving the Protocol ......................................................... 2-11
2-10 Saving the Stage Coordinate Information ....................... 2-12
2-11 Exiting from This Software ............................................. 2-12
2-12 Exiting from the FLUOVIEW software ............................. 2-12

3 System Requirements ......................................................... 3-1
1 Software Description

This chapter describes the functions and setup methods of the software.

1-1 Starting the Software

1. Click the <Start> button on the bottom right of the Windows screen.


4. Message to confirm stage move to home position and escape of objective lens from stage appears. Click <OK> button and the stage will move to mechanical home position.

[Detect the mechanical origin] check box.
Remove check when stage is not moved to mechanical origin.

[Escape automatically] check box
Remove the check when you do not escape the objective lens from the stage (when using the Motorized microscope).

5. The main screen of the software shown below appears.

[Exit] button
Click to exit from the software.

[Minimize] button
It makes window to minimum size by turning it to icon.

[Stage Map] window
Shows the coordinate positions including the current stage position and registered points.

[X Y Stage Control] window
Window for use in registration, confirmation and editing of stage coordinate information by controlling the stage.

<Close> button
Click to close the [Stage Map] window.

Fig. 1-1 Main Window
1-2 Moving the Stage

Move stage to the position where the specimen is observed.

1-2-1 Specifying approximate position on stage

Move stage directly to the position of observation.
It is useful to move the stage to approximate position before specifying the accurate position. Double-click the position where you wish to move on panel of [Stage Map] window.

[Stage Map] panel
Double-click the position you wish to move inside the panel.

If you want to register this position as the stage coordinate information, refer to section 1-3, “Registering the Stage Coordinate Information”.

Fig. 1-2  [Stage Map] Window
**1-2-2 Moving the Stage Step by Step**

Move stage per step specified.

It is useful when you wish to move the position of observation in small movement.

![Fig. 1-3  [XY Stage Control] Window](image)

**Arrow buttons**
Stage moves in arrow direction. The movement step is the value entered in the [Step Size] text box.

**+ button**
Click to return the stage to the set origin.

**<GO> button**
Functions as the stop button during stage movement. Click if you want to stop movement.

**[Step Size] text box**
Set the distance of stage movement step per click of an arrow button.

If you want to register this position as the stage coordinate information, refer to section 1-3, “Registering the Stage Coordinate Information”.
1-2-3 Moving the Stage to the Specified Coordinate Position

The following operation allows the stage to be moved to the observation position by specifying its coordinates. This operation is effective when the coordinates of the observation position is already known and you want to move the stage there directly.

1. Enter the coordinates of position to which you wish to move the stage in X-axis and Y-axis at [Control Pos] text box and click <Go> button.

[Control Pos] text box
Enter the coordinates of the move position in the X and Y text boxes.

<GO> button
When clicked, the stage moves to the coordinates displayed in the [Current Pos] text box. During stage in motion, this button changes to <Stop> button. Click <Stop> button when you wish to stop.

Fig. 1-4  [XY Stage Control] Window

If you want to register this position as the stage coordinate information, refer to section 1-3, "Registering the Stage Coordinate Information".
1-2-4 Moving the Stage to a Preset Position

This operation allows the stage to be moved to one of the coordinate positions set in advance.

This operation requires stage coordinate information to be registered in advance.

For details, see section 1-3, “Registering the Stage Coordinate Information”.

1. Double-click column of No. of which track coordinate that is required to move is memorized in [Stage Coordinate Information Registration] sheet on [XY Stage Control] window.

Fig. 1-5  Main Screen

The stage coordinate information contains the X- and Y-axis coordinates of the registered position. (It also includes the Z-axis coordinate when the FV300/500 is used.)
1-2-5 Moving the Stage to an Indexed Area

This operation allows the stage to be moved to one of the indexed areas, each of which having the specified index size (field size).

This operation is effective when you want to acquire images of adjacent areas on the stage by moving the stage position to the desired areas.

1 Moving the periphery of current stage position

1. Select [Current Pos] from [Large View] menu of [Stage Map] window so that peripheral indexes (5x5) will be displayed - enlarged around center of current stage position.

2. Double-click inside grid of any index at [Stage Map] so that the stage moves to center of the said index.

3. To return to normal display, selected the [Normal View] menu in the [Stage Map] window.
While the [Stage Map] panel is displayed - enlarged, when zoom magnification and object lens magnification are changed on FLUOVIEW software, please select the [Edit] menu - [Refresh]. [Stage Map] will be updated. When scanning condition is changed on FLUOVIEW software and, to fan out the index size changed, it is necessary to update [Stage Map] panel.

2 Moving periphery of stage position registered

1. Select [Registration Pos] from [Large View] menu of [Stage Map] window so that the following dialog box will appear

![Set Registration Pos dialog box](image)

Fig. 1-7 [Set Registration Pos] dialog box

2. Enter stage position number registered in [Registration No.] text box and select <Set> button. Indexes of periphery (5x5) will be displayed – enlarged around center of the registered stage position of which number was entered.

![Enlarged [Stage Map] Panel](image)
Index size can be changed. For further details, see section 1-7-3, “Changing the Index Size”.

3. If you double-click any grid of indexes on [Stage Map] panel, the stage will move to center of the said index.


**NOTE**

While [Stage Map] panel is displayed – enlarged and zoom magnification and objective lens magnification are changed on FLUOVIEW software, please select [Refresh] from [Edit] menu. [Stage Map] will be updated. When scanning condition is changed on FLUOVIEW software and, to fan out the index size changed, it is necessary to update [Stage Map] panel.

---

**One Point!**

Select [Registration No.] from [View] menu of [Stage Map] window (check mark should appear at the item) and the number that stage coordinates are registered will appear. Select [Registration FileName] from [View] menu (check mark should appear at the item) and file name will appear inside the index (grid).
1-3 Registering the Stage Coordinate Information

The stage coordinate information contains the X- and Y-axis coordinates of the registered position. (It also includes the Z-axis coordinate when the FV300/500 is used.)

1. Move the stage to the desired position as described in section 1-2, "Moving the Stage".

2. Click the <Add Pos> button in the [XY Stage Control] window. The coordinates of the current position are added to the [Stage Coordinate Information Registration] sheet.

Register other desired observation positions by moving the stage to each of them and adding its stage coordinate information.

[Stage Coordinate Information Registration] sheet
Stage coordinate information registered will be displayed in X, Y and Z axis. You can change each setting when you input in each text box directly.

The Z-axis setting is displayed when FLUOVIEWS software is started. The displayed values are obtained from the settings made with the FLUOVIEWS software. In [Comment] column, you may enter comment regarding stage coordinates.
1-3-1 Auto Registration of Stage Coordinate Information Specifying Index Numbers

If you specify reference position as center of region (center of rectangular region) to acquire coordinate information and number of indexes, you can program the region to acquire coordinate information. You can acquire adjacent images by moving the stage in every index size (size of view) programmed inside the region.

1. In the panel of the [Stage Map] window, click the mouse on the position you want to set as the reference position.
   A green handle appears.
2. Select [Define Region] – [by Size] from [Edit] menu of [Stage Map] window and the following sub menu will appear. Select number of indexes (column by row) to queue.

   Select [More] from sub menu and you can program row number and column number you desire. The following dialog box will appear. Enter number of rows in [Row] text box and number of columns in [Column] text box and then, select <Set> button.

   ![Fig. 1-9 Define Region by Size Dialog box](image)
3. The stage coordinate information of each indexed area around the current position is registered automatically in order of the displayed area numbers.

Fig. 1-10  [Stage Map] Panel with Tiled Indexed Areas

The index size can be changed by the user. For details, see section 1-7-3, “Changing the Index Size”.

1-3-2 Auto Registration of Stage Coordinate Information Specifying Region

If you specify two points (start point and end point) that are diagonally positioned each other inside region (rectangular region) to acquire coordinate information, the region specified will be equally divided in index size (size of view) programmed. You can therefore acquire adjacent images by moving the stage in every index divided.

Fig. 1-11  [Define Region by Bounds] Dialog box

2. Move stage to start point of rectangular region and select <Start Pos> button.

3. Move stage to end point of rectangular region and select <End Pos> button. Stage coordinate information will be automatically registered in sequence of number inside the display. Regarding method of stage move, refer to 1-2 “Moving the Stage”.

Fig. 1-12  [Stage Map] Panel with Tiled Indexed Areas
Clicking a menu name in the [XY Stage Control] window or [Stage Map] window displays the control menu, which contains commands for controlling the window.

### 1-4-1 [XY Stage Control] Window

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>New</td>
<td>Creates a new stage coordinate information registration sheet.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Loads a CSV file to edit the stage coordinate information.</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Saves the stage coordinate information by overwriting previous data.</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Saves the stage coordinate information being edited in a different file name and/or location.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exits from the application.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Copy</td>
<td>Copies the selected string, cell or track into the clipboard.</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Inserts the data in the clipboard in the cursor position.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes the selected string, cell or track.</td>
</tr>
<tr>
<td></td>
<td>Re-register to PAPP</td>
<td>Re-registers the stage coordinate information in the protocol processor.</td>
</tr>
<tr>
<td></td>
<td>(It appears when FLUOVIEW software is linked)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Register the selected comment as base comment</td>
<td>When stage coordinate information is newly added to [Stage Coordinate Information Registration] sheet, it programs default comment registered in [Comment] column.</td>
</tr>
<tr>
<td></td>
<td>Adjust the shift of Z axis</td>
<td>When Z position is displaced due to deflection of microscope or ambient temperature change, it programs the shift stroke of Z axis if Z range is adjusted.</td>
</tr>
<tr>
<td></td>
<td>(It appears when FLUOVIEW software is linked)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open PAPP Track Editor</td>
<td>It displays input supporting function to the track of protocol processor. For further details, see 2-4-3 Display of input supporting function to track of protocol processor.</td>
</tr>
<tr>
<td></td>
<td>(It appears when FLUOVIEW software is linked)</td>
<td></td>
</tr>
<tr>
<td>Menu</td>
<td>Sub-menu</td>
<td>Function</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View</td>
<td>On Top</td>
<td>When this is checked, the [XY Stage Control] window is always displayed at the front.</td>
</tr>
<tr>
<td></td>
<td>Registration</td>
<td>When this is checked, the [Registration] group box is displayed.</td>
</tr>
<tr>
<td></td>
<td>Stage Map</td>
<td>When this is checked, the [Stage Map] panel is displayed.</td>
</tr>
<tr>
<td></td>
<td>Separate Stage Map</td>
<td>When this is checked, the [Stage Map] panel can be moved independently from the [XY Stage Control] panel.</td>
</tr>
<tr>
<td>Options</td>
<td>Preferences</td>
<td>Displays the [Preference] dialog box for use in setting of details.</td>
</tr>
<tr>
<td></td>
<td>With Protocol Processor</td>
<td>Connects or disconnects the protocol processor. When this is checked, the software is connected and the [TIEMPO] group box and item “TIEMPO” in the [Stage Coordinate Information Registration] sheet are displayed.</td>
</tr>
<tr>
<td></td>
<td>Set PP Track Info to FV</td>
<td>It sets setting information that meets with the track selected to FOLUOVIEW software. For further details, see 2-4-2 Setting information that meets with track selected to FLUOVIEW software.</td>
</tr>
</tbody>
</table>
### 1-4-2 [Stage Map] Window

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Register Software Origin</td>
<td>Registers the current position as the origin.</td>
</tr>
<tr>
<td></td>
<td>Add Current Position</td>
<td>Registers the current position in the [Stage Coordinate Information Registration] sheet.</td>
</tr>
<tr>
<td><strong>Define Region</strong></td>
<td>By Size</td>
<td>Registers the coordinate positions of the grids (indexes) around center of the current position in the [Stage Map] panel, divided according to the index size (view size), automatically as stage coordinate information. For further details, refer to section 1-3-1 “Auto Registration of Stage Coordinate Information Specifying Index Numbers”.</td>
</tr>
<tr>
<td></td>
<td>By Bounds</td>
<td>Registers positions divided per index size (view size) specified in the region that is specified as region to acquire coordinate information in [Stage Map] panel as plural numbers of coordinate information automatically. For further details, refer to 1-3-2 “Auto Registration of Stage Coordinate Information Specifying Region”.</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td></td>
<td>Refreshes the enlarged view by obtaining the current image size and index size. This item is available when the image is being enlarged.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Registration No.</td>
<td>It indicates number of registration for stage coordinates registered inside index in [Stage Map] panel.</td>
</tr>
<tr>
<td></td>
<td>Registration FileName</td>
<td>It indicates file name inside index in [Stage Map] panel.</td>
</tr>
<tr>
<td><strong>Large View</strong></td>
<td>Current Pos</td>
<td>Enlarges the peripheral areas around current stage position in the [Stage Map] panel. For details, see section 1-2-5, “Moving the Stage to an Indexed Area”.</td>
</tr>
<tr>
<td></td>
<td>Registration Pos</td>
<td>Enlarges the peripheral areas around stage being registered in [Stage Map] panel. For further details, refer to 1-2-5, “Moving the Stage to an Indexed Area”.</td>
</tr>
<tr>
<td><strong>Normal View</strong></td>
<td></td>
<td>Returns the image in the [Stage Map] panel to the normal size.</td>
</tr>
</tbody>
</table>
1-5 Stage Coordinate Information Markings Used in the [Stage Map] Panel

The [Stage Map] panel uses the following markings to indicate the registered coordinate positions, current position, etc.

<table>
<thead>
<tr>
<th>Marking Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin</td>
<td>A red handle indicates the registered origin.</td>
</tr>
<tr>
<td>Current position</td>
<td>A green handle indicates the current position.</td>
</tr>
<tr>
<td>Registered point</td>
<td>White dots indicate the positions registered in the [Stage Coordinate Information Registration] sheet.</td>
</tr>
<tr>
<td>Registered point confirmation</td>
<td>When a registered number in the [Stage Coordinate Information Registration] sheet is selected, a white handle indicates the position corresponding to the registered number.</td>
</tr>
</tbody>
</table>
1-6 Enlarging the [Stage Map] Panel

When you select [Current Pos] from [Large View] menu of [Stage Map] window, the peripheral indexes (5x5) are displayed – enlarged around center of current stage position.

In addition, when you select [Registration Pos] from [Large View] menu and specify number of stage being registered on dialog box that appears, the peripheral indexes (5x5) are displayed – enlarged at center of stage being registered.

For further details, refer to 1-2-5 “Moving the Stage to an Indexed Area”.

![Enlarged Stage Map Panel]

**TIP**

The index size can be changed by the user.

For details, see section 1-7-3, “Changing the Index Size”.

To return from the enlarged display to the normal display, select the [Normal View] menu in the [Stage Map] panel.
1-7 Changing the Settings

This section describes how to change the stage control-related settings including the stage movement speed, stage movement acceleration, XY stage connection port, etc.

The basic setting procedure is as follows:

Fig. 1-14  [Preference] Dialog Box

1-7-1 Setting the Stage Control Parameters

Set the stage movement speed, stage movement acceleration, stage returning to the mechanical origin and connection port as described below.

1 Setting the stage movement speed and stage movement acceleration

When a quick stage move is required, set the value of moving speed and acceleration larger and, on the other hand, if you wish to minimize the stage move in case of wafer-dip observation in a Petri dish, it is effective that you set the value of moving speed and acceleration smaller.


[Speed] scale
Select the stage movement speed.

[Acceleration] text box
Enter the stage movement acceleration value. Enter a value in the unit of 1.0 (mm/sec²).
2 Returning the stage to the mechanical origin

The mechanical origin is the origin point specific to the stage. You can set the software origin in the desired position. The stage is controlled with reference to an origin, but using the mechanism origin as the reference position makes the stage control difficult. The stage control can be made easy by setting the software origin in the position you want to use as the reference position for observation.

Returning the stage to the mechanical origin is executed automatically at the start of this software.

With certain stages, very small errors are accumulated after repeated movements. This operation returns the stage to the mechanical origin in order to nullify the accumulated errors.

After the stage has been returned to the mechanical origin, it can be moved from there by the software control.

3 Setting the connection port

This setting is required when changing the connection port or connecting a new stage.

1. After the port to which the XY stage has been changed, open the drop-down list in the [Connect Using] group box, select the new connection port and click the <Connect> button.
1-7-2 Alignment of moving direction

Alignment of moving direction is done.
When the stage is moved in the state that it is not precisely connected, it would move to X or Y direction as it has been displaced from the specimen.
By aligning moving direction, the displacement with coordinate can be compensated.
Alignment should be executed by programming two points on specimen as reference in X direction.

1. In the [Preference] dialog box, select [Manipulation] to display the sub-panel.

   - **<1st Pos> Button**
     Set 1st point on X direction (X and Y coordinates).

   - **<2nd Pos> Button**
     Set 2nd point on X direction (X and Y coordinates).

   - **<Clear> Button**
     It returns 1st and 2nd point coordinates or alignment to original positions.

   - **Fig. 1-15 [Manipulation] Sub-panel**

2. Move stage to the 1st point in X direction and select <1st Pos> button.
3. Move stage to the 2nd point in X direction and select <2nd Pos> button. The straight line that passes through two points will be aligned as X-axis. Regarding method of stage move, refer to 1-2 “Moving the Stage”.

When the 1st and 2nd points are specified, the software performs the following processing.

1. Assumes a right-angled triangle having the line connecting the two points as the hypotenuse and computes \( \sin \theta \) and \( \cos \theta \) of this triangle.
2. Performs affine transformation using the obtained trigonometric functions.
3. Based on the results obtained above, corrects the error in coordinates between the stage and specimen as shown below.

1-7-3 Changing the Index Size

When connecting the images of adjacent areas after acquiring them, certain software is incapable of connecting them properly if the images of adjacent areas do not have some overlapped areas.

The degree of overlapping between the images of adjacent area can be adjusted by changing the index size.

1. In the [Preference] dialog box, select [Index Size] to display the sub-panel.

[Based on Scan Size] Check box
In case that calculation of index size is required, based on scanning size as reference, check the check box.

[X Index] / [Y Index] Text box
Shows the index sizes in X- and Y-axis values.

Adjustment slider
Shows the percentage of the index size. The setting can be changed by direct entry of the value.
2. In case that calculation of index size is required, based on scanning size as reference, check the check box of [Based on Scan Size].

3. When check box of [Based on Scan Size] is checked, you can program the percentage of index size (in left side text box of adjuster slider), using adjuster slider. Depending upon the value set, the index size will be calculated and displayed in text boxes – [X Index] and [Y Index] respectively.

![Diagram](image)

Field if 90% index size
Actual field (White parts are the margins overlapped with the images of adjacent areas)

In case that the check box of [Based on Scan Size] is not checked, you can enter the value directly in text boxes – [X Index] and [Y Index] respectively.

4. After completing all settings, click the <Close> button on the top right of the dialog box to close it.

**1-7-4 Default setting of file name to be registered automatically**

Format of file name to be registered automatically in [File Name] column is set at registration of stage position.


![Preference panel](image)

**Fig. 1-17  [Software] Sub panel**
2. When you register directory for save automatically, check the check box of [Directory name] and enter directory name in the text box. When you assign consecutive number to directory name, see the following table 1-1 [File Name] column Registration Example] and enter the name.

3. When you register file name for save automatically, check the check box of [File Name] and enter file name in the text box. When you assign consecutive number to file name, see the following table 1-1 [File Name] column Registration Example] and enter the name.

<table>
<thead>
<tr>
<th>Input data to text box</th>
<th>Registration example of [File Name]</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Directory name]</td>
<td>[File name]</td>
</tr>
<tr>
<td>R***</td>
<td>R***</td>
</tr>
<tr>
<td>R**</td>
<td>R*****</td>
</tr>
<tr>
<td>OLY</td>
<td>R***</td>
</tr>
<tr>
<td>(blank)</td>
<td>OLY</td>
</tr>
<tr>
<td>(blank)</td>
<td>(blank)</td>
</tr>
</tbody>
</table>

Table 1-1 [File Name] Registration Example
Multipoint time-lapse observation using a protocol processor is possible when this software is used together with the FV300 or FV500 system and the FV-TIEMPO (Time Course Software).

The observation procedure is as shown below.

* For the operations in each step, refer to the section or manual mentioned inside parentheses ([ ]).

<table>
<thead>
<tr>
<th>Turn power on and start the FLUOVIEW software.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Start this software and protocol processor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-1, “Starting This Software and Protocol Processor”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connect this software and protocol processor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-2, “Connecting This Software and Protocol Processor”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start repeated scanning and determine the XY stage coordinate information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-3, “Setting the Stage Coordinate Information”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit the protocol file.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Set the interval and number of protocol repetitions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-4, “Editing the Protocol File”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Acquire Images Using the Protocol Processor (XYZ and XYZT Images)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-5, “Acquiring Images”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit the XYZ and XYZT images.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-8-1, “Building Extended Focus Image from XYZ Images” in Volume [OPERATION INSTRUCTIONS] of the FV300/500 User’s Manual)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Save the images.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Save the protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-4-3, “Saving the Protocol” in Volume [OPERATION INSTRUCTIONS] of the FV300/500 User’s Manual)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Save the stage coordinate information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-10, “Saving the Stage Coordinate Information”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exit from this software.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Section 2-11, “Exiting from This Software”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exit from the FLUOVIEW software and turn power off.</th>
</tr>
</thead>
</table>
2-1 Starting This Software and Protocol Processor


   Protocol processor boots up.

2. This software starts up. For further details, see 1-1 Starting the software.

   ![Fig. 2-1] [Time Series] Sub-panel in the [Acquire] Panel of the FLUOVIEW Software

   ![Fig. 2-2] Display when protocol processor and this software started
2-2 Connecting This Software and Protocol Processor


The [TIEMPO] group box and [Stage Coordinate Information Registration] sheet displays the [PP Track No.] and [File Name] fields.

- **[TIEMPO] group box**: Set the repetition processing used by the protocol processor (For statement, etc.) here.

- **[Set to Protocol Processor] check box**: When the <Add Pos> button is clicked, the creation of the protocol for the added coordinate position is enabled.

- **[PP Track No.] field**: Shows the track number of the protocol processor corresponding to the current track. The protocol processor's track is enabled when this is checked.

- **[File Name] field**: Specify the image file name to be saved after executing the protocol.
One Point!

Click [Option] menu on [PAPP] window and put a check on [Start up with XY Stage] and boot up protocol processor so that this software would automatically start up and protocol processor would be connected.
2-3 Setting the Stage Coordinate Information

While performing repeated scanning, set the stage coordinate information in the [Registration] group box.

1. Set the conditions for repeated scanning in the [Acquire] panel of the FLUOVIEW software.

2. Click the <XY Repeat> button in the [Acquire] panel of the FLUOVIEW software to execute repeated scanning. The acquired image is displayed in the [Live] panel.

3. Adjust the image brightness.

4. Move the stage to an approximate area near the observation target position.
   In the [Stage Map] window panel, double-click on the approximate position you want to move the stage.
   For details, see section 1-2-1, “Moving the Stage by Specifying the Approximate Position”.

5. Using the joystick provided with the XY stage, move the stage to the approximate area near the position you want to observe.

6. Move the stage to the observation position using the arrow buttons in the [Control] group box in the [XY Stage Control] window.
   For details, see section 1-2-2, “Moving the Stage Step by Step”.

7. Click the <STOP SCAN> button on [Acquire] panel of FLUOVIEW software to stop repeated scanning.

8. If XYZ observation is required, set it in the [Z Stage] sub-panel in the [Acquire] panel of the FLUOVIEW software.
9. Click the <Add Pos> button in the [XY Stage Control] window. The coordinate information of the current position is added in the [Coordinate Information Registration] sheet. In an interlocked operation with this software, the protocol is also added in the sheet in the [PAPP] window.

10. Repeat steps 1 to 6 for each of the coordinate positions to be observed. This software and protocol processor are set up as follows.

Fig. 2-5  [XY Stage Control] window where the coordinate information is registered.

Fig. 2-6  [PAPP] window where the protocol is set up automatically by registration of coordinate information.

Registering coordinate information using this software results in automatic creation of a “For” statement.
### 2-4 Editing the Protocol File

Edit the protocol file to be used in the multipoint time-lapse editing.

For details, refer to section 2-4-2 “Editing the Protocol” in the FV-300/500 User’s Manual.

#### 2-4-1 Setting repeated processing to protocol processor

The repeated processing of the protocol processor can also be set in from the [TIEMPO] group box in the [XY Stage Control] window.

![XY Stage Control Window](image1)

**[PAPP] Window**

![PAPP Window](image2)

1. [Interval] text box, drop down list:
   It works as in the same case as [PAPP] window (4). Unit of interval time is to be selected from drop down list and interval time to execute protocol by returning from [Next] track to [For] track should be put in text box for repeated process of protocol processor.

2. [Repeat] text box:
   It works as in the same case as [PAPP] window (5). Designate cycles of repeated process for protocol processor.

3. [Path] button:
   It works as in the same case as [PAPP] window (6). Designate destination to save image acquired.

For further details of [PAPP] window operation, see FV300/500 User’s Manual, 2-4-2 Editing protocol.
2-4-2 Setting information that meets with track selected to FLUOVIEW software

It is possible to set the setting value of each track for protocol processor that meets with each track in [Stage Coordinates Information Registration] on [XY Stage Control] window to FLUOVIEW software.

1. Select [Set PP Track Info to FV with position movement] from [Option] menu and make it to the state that a check is entered.

2. Double-click No. column of the track to be set from [Stage Coordinates Information Registration] on [XY Stage Control] window.
   The setting information of track to protocol processor will be set to FLUOVIEW software.
   Simultaneously, the stage moves to the position where the track is selected.

**NOTE**


**NOTE**

If No. column is double-clicked in the state the [Set PP Track Info to FV with position movement] is not checked, the stage moves to the position where the track is selected but setting to FLUOVIEW software is not executed.

2-4-3 Display of input supporting function to track of protocol processor

[Track] window that is input supporting function to protocol processor can be displayed from [XY Stage Control] window. By checking check box of each group on [Track] window, it is possible to get or set necessary information only from or to FLUOVIEW software. The setting information that differs between [PAPP] window and FLUOVIEW will be highlighted and displayed in orange. For details
of [Track] window, see FV300/500 User’s manual, 2-4-2-4 Input supporting function.

Display method:


2. Select [Open PAPP Track Editor] from [Edit] menu. [Track] window of track to protocol processor that meets with track selected would be displayed. For details of [Track] window, see FV300/500 User’s manual, 2-4-2-4 Input supporting function.

```
<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Delete</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Register the selected comment as base comment...</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Adjust the shift of Z axis...</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Re-register to PAPP</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Open PAPP Track Editor...</td>
<td>Ctrl+E</td>
</tr>
</tbody>
</table>
```

TIP

Click (mouse-right side) over [Stage Coordinates Information Registration] sheet; and it is possible to select [Open PAPP Track Editor] or display [Track] window.

TIP

To reflect all settings of FLUOVIEW software to the tracks in [XY Stage Control] window, select [Re-register to PAPP] from [Edit] menu.

2-5 Acquiring Images

Execute the created protocol to acquire the multipoint time-lapse images.

1. Click the <Start> button in the [PAPP] window.

2-6 Z range Offset

In case that Z position is displaced due to deflection of microscope or ambient temperature change, set [Z Pos] (Current Pos) once again with use of [XY Stage Control] window.

1. Select registered number of track (stage coordinates information) to adjust Z position on [Stage Coordinates Information Registration] sheet on [XY Stage Control] window and double-click it to move the stage.
2. Select [Adjust the shift of Z axis] from [Edit] menu of [XY Stage Control] window so that the following dialog box will appear.

![Fig. 2-7  [Adjust the shift of Z axis] Dialog box](image)

3. Do mouse right-click over [Stage Coordinates Information Registration] sheet on [XY Stage Control] window and select [Adjust the shift of Z axis] so that the same operation as described above can be done.


5. Watching [Live] panel, adjust Z position, using <Z stage coarse adjustment> button or <Z stage fine adjustment> button on [Z Stage] sub panel. Shift distance of Z position (the difference between the value in [Current Pos] text box and the value in [Z Pos] of track selected with XY Stage Software will be displayed in [Z Shift] text box of [Adjust the shift of Z axis] dialog box. For details, refer to 1-2-12-7 “Setting the Multiple sections to be Observed” in Volume [OPERATION INSTRUCTIONS] of the FV300 User’s Manual or 1-2-8-7 “Setting the Multiple sections to be Observed” in
6. Upon completion of Z position adjustment, select <Set> button on [Adjust the shift of Z axis] dialog box. Shift distance of Z position will be registered in [Z Pos] column of [Stage Coordinates Information Registration] sheet of XY Stage Software.

7. Select <STOP SCAN> button on [Acquire] panel of FLUOVIEW software so that the repeat scanning will be stopped.

**TIP**

In case that the shift distance of Z position is already known, you may enter the shift value directly in [Z Shift] text box on [Adjust the shift of Z axis] dialog box without executing scan and moving the stage to acquire the shift distance.

**NOTE**

When you use FV300/500 system that Z motor is not equipped, you cannot use [Adjust the shift of Z axis] function.

---

**2-7 Editing Images**

Edit the acquired XYZ or XYZT images.


**2-8 Saving Images**

Save the edited images.

For details, refer to 2-3-1 “Saving Images” and after in Volume [OPERATION INSTRUCTIONS] of the FV300/500 User’s Manual.

**2-9 Saving the Protocol**

Save the protocol used in the multipoint time-lapse observation in the CSV file format.

For details, refer to 2-4-3 “Saving the Protocol” in Volume [OPERATION INSTRUCTIONS] of the FV300/500 User’s Manual.
2-10 Saving the Stage Coordinate Information

Save the stage coordinate information used in the multipoint time-lapse observation in the CSV file format.
In the [XY Stage Control] window, select the [File] menu – [Save As], name the information file and save it.

2-11 Exiting from This Software

In the [XY Stage Control] window, select the [File] menu – [Exit].

2-12 Exiting from the FLUOVIEV software

Exit from the FLUOVIEV software.
### 3 System Requirements

<table>
<thead>
<tr>
<th>Unit</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer system</td>
<td>Same as the FLUOVIEW FV300/500 systems.</td>
</tr>
<tr>
<td>Monitor</td>
<td></td>
</tr>
<tr>
<td>Image input block</td>
<td></td>
</tr>
<tr>
<td>Image memory</td>
<td></td>
</tr>
<tr>
<td>Input memory</td>
<td></td>
</tr>
<tr>
<td>XY stage</td>
<td>MPT-AS01-FV / MPT-AS02-FV (BIOS series - SIGMA KOKI Co., Ltd.)</td>
</tr>
<tr>
<td></td>
<td>ProScan™ (Prior Scientific Instruments, Ltd.)</td>
</tr>
</tbody>
</table>

ProScan is registered trademarks of Prior Scientific Instruments, Ltd.